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1. Introduction 

1.1 Assay Description 

Apoptosis, or programmed cell death, is a natural process of cellular self-destruction. Apoptosis is a part 

of routine cell turnover and tissue homeostasis, prevalent in epithelial cells, erythrocytes, and other cell 

types genetically programmed to have a limited life span. It is also important in embryogenesis, 

maintenance of immune tolerance, and development of the nervous system. Apoptosis can be induced 

either by a stimulus, such as irradiation or toxic drugs, or by removal of a repressor agent. The cells 

disintegrate into membrane-bound particles that are then eliminated by phagocytosis. Problems with the 

regulation of apoptosis are thought to be linked to many cancers, degenerative diseases, and autoimmune 

diseases, making apoptosis a key target in many fields of clinical research. 

Necrosis is the death of cells or tissues from severe injury or disease, especially in a localized area of the 

body. Causes of necrosis include inadequate blood supply (as in infarcted tissue), bacterial infection, 

traumatic injury, and hyperthermia. 

Annexin V and propidium iodide are used to measure apoptosis and necrosis. Annexin V is a member of 

the annexin family of intracellular proteins that binds to phosphatidylserine (PS) in a calcium-dependent 

manner. PS is normally only found on the intracellular leaflet of the plasma membrane in healthy cells, 

but during early apoptosis, PS translocates to the external leaflet. Fluorochrome-labeled Annexin V can 

then be used to specifically target and identify the PS on the surface of apoptotic cells. Annexin V binding 

alone cannot differentiate between apoptotic and necrotic cells. Propidium Iodide (PI) solution is a 

membrane-exclusion dye that permeates cells with compromised cell membranes and binds to DNA. Early 

apoptotic and healthy cells with intact membranes will exclude PI, while late stage apoptotic and necrotic 

cells with compromised membranes are stained. Use of both Annexin V-FITC and PI allows researchers to 

characterize a cell population based on % normal, % apoptotic, and % necrotic /very late-stage apoptotic 

cells.  

For additional apoptosis information, please see below reference articles, include usage on Cellometer: 

• Elmore S. (2007). Apoptosis: A Review of Programmed Cell Death. Toxicol. Pathol. 35(4):495-516.  

• Rastogi RP, et al. (2009). Apoptosis: Molecular Mechanisms and Pathogenicity. EXCLI Journal. 8:155-181. 

• Berger EA, et al. (2013). HIF-1α Is Essential for Effective PMN Bacterial Killing, Antimicrobial Peptide 

Production and Apoptosis in Pseudomonas aeruginosa Keratitis. PLoS Pathogens 9(7). 

• Verma M, et al. (2013). Sirtuin-3 Modulates Bak/Bax Dependent Apoptosis. Journal of Cell Science 

126(1):274-88.  

1.2 Materials Supplied 

Reagent Catalog number Volume 

ViaStain™ Annexin V-FITC CS1-0114-1 500 µL 
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1.3 Materials Required 

• ViaStain™ Annexin V Binding Buffer for Cellometer (Cat. # CS0-0115-1) 

• ViaStain™ PI Apoptosis Staining Solution for Cellometer (Cat. # CS1-0116-1) 

• Microcentrifuge tubes 

• Pipette and pipette tips 

• Trypsin EDTA (if working with adherent cells) 

• Phosphate Buffered Saline (PBS) 

• Cellometer counting slides (Cat. # SD100 or PD100) 

 

1.4 Instrument and Software Requirements 

• Cellometer Spectrum Fluorescent Cell Counter with Fluorescence Optics Modules S1-534-470 
and S1-655-527 

• Operating Computer with: 

o Cellometer Spectrum software 

o FCS Express Software and license (De Novo Software) 
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2 Assay Protocol 

2.1 Preparation of Control Samples 

1. A positive control should be used to check exposure time and optimize the y-axis gate for 

apoptotic and non-apoptotic cells. A positive control may be generated by exposing cells to an 

apoptosis inducing pharmacological agents such as α-TOS and etoposide. For Cellometer 

examples, Jurkat cells were incubated overnight with 10 µM α-TOS or Staurosporine. 

2. A negative control (untreated cells) should be tested to determine baseline cell concentration, % 

viability, and % apoptotic cells. The negative control is used to optimize the x-axis gate for live 

and dead cells. 

3. Positive and negative controls should be processed at the same time using the staining and data 

acquisition procedures outlined below. 

2.2 Preparation of Adherent Cells for Staining 

1. Using 1x Trypsin (EDTA), trypsinize cells until they have lifted off the plate. 

2. Centrifuge cells at 200 – 400 x g for 5 min. 

3. Remove the supernatant carefully and resuspend cells in 1 mL of 1 x PBS. 

2.3 Staining Procedure 

1. Verify the concentration of the positive / negative controls and cell samples using the 

Cellometer Spectrum Fluorescent Cell Counter. 

2. Use the Cellometer Sample Adjustment Calculator to generate a cell sample with a 

concentration between 2 and 3 million cells per mL (2-3 x 106 cells/mL). See section 5.0: Using 

the Sample Adjustment Calculator. 

3. Into a new tube, pipette 50 µL of cells that are at a concentration of 2-3 x 106 cells/mL. Spin 

down cell sample at 200 – 400 x g for 5 min. 

4. Remove the supernatant carefully and resuspend cells in 40 µL of Annexin V Binding Buffer 

(Component C). Mix by pipetting up and down at least 10 times. 

5. Add 5 µL of Annexin V-FITC (Component A). 

6. Add 5 µL of PI solution (Component B). 

7. Gently pipette the cells up and down ten times, then incubate for 15 min at RT (25°C) in the 

dark. 

8. Add 250 µL of 1x PBS. 

9. Centrifuge at 200 – 400 x g for 5 min. 

10. Remove the supernatant carefully and resuspend cell pellet in 50 µL of Annexin V Binding Buffer 

(Component C) and mix by pipetting up and down ten times. 
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2.4 Data Acquisition 

1. Select the FCS_Annexin V-FITC + PI or CBA_Apoptosis Annexin V + PI 

assay from the Assay drop-down menu in the upper left corner of the 

main Spectrum software screen. The apoptosis assay should be run 

with the default software settings and the exposure times indicated 

below in step 3. If you suspect that the settings may have been 

changed, review the default software settings in Section 4. 
2. If running the FCS_Annexin V-FITC + PI or CBA_Apoptosis Annexin V + 

PI assay for the first time, the default exposure time MUST be updated. 

Click on the pencil icon under Assay on the main Spectrum screen. 

 

3. Adjust the exposure for the Annexin V FITC (F1) and PI (F2) 

channels. 

Annexin V FITC (F1) Exposure PI (F2) Exposure 

400 msec 250 msec 

4. To import the most current FCS Express Layout for the Annexin V-
FITC / PI assay, see Section 6 Importing a New FCS Express Layout. 

5. Gently mix the cell sample by pipetting up and down at least ten 
times, then load 20 μL into the Cellometer imaging chamber and 
insert slide. 

6. Wait 60 seconds for the cells to settle in the chamber. 
7. Type a name for your sample into the Sample ID text box. 
8. Click Preview Brightfield Image at the bottom left of the main 

Spectrum screen. 
9. Turn the focus knob and adjust focus for the bright field image. Cells in focus for the apoptosis 

assay will have a bright center and dark outline. There should be a crisp contrast between 
background and the cell membrane. See Focus Guide below. 
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10. Click Stop Preview. 
11. Click the Preview F1 Image button (bottom left of screen) and verify that the fluorescence signal 

displays as 100% of range. 
 

Example images of cells stained with Annexin V-FITC. Optimal exposure time will generate a bright image 
with well-defined fluorescent spots (middle image). A sample is under exposed when the images are dark 
with insufficient fluorescent signal, whereas over exposure yields images that are too bright with 
fluorescent spots that are less distinct from background.  

 
12. Click Preview F2. The F2 (PI) channel should be set to 250 msec exposure for Spectrum. 
13. Click the Count button at the bottom of the screen. 
14. When counting is complete, an initial Results Table will appear on the screen. For optimal 

results, the Total Count should be between 2,000 and 8,000 cells (4,000 cells is optimal). If the 
Total Count is < 2,000 repeat data acquisition with a more concentrated sample. For larger cells 
(>15 µm in diameter) a minimum of 2,000 cells is acceptable. 
 

Under Exposure Optimal Exposure Over Exposure 

Optimal Focus Fuzzy border Dark Center 
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15. Click the Close button at the bottom right corner of 
the Counting Results table. Select the BR Counted 
image at the right-hand side of the screen. 

16. Review the counted image to confirm that cells are 
being counted correctly. Individual cells within 
clumps should be circled in green, indicating that 
they are being counted individually. 
 

2.5 Exporting and Saving Data Files 

1. Once cells are correctly counted, click on the report icon at the top left of the screen, then click 

the Export button at the bottom right of the Counting Results screen. 

 

 

2. Confirm that “Export data to Nexcelom Data Package” is selected, and that “When done open 
Nexcelom Data Package with FCS Express” is NOT selected, then click Continue. 

 
3. Select a location and enter a name for the data package. Two items will be saved in the 

designated location with the file name entered: 
 
Raw Nexcelom data file (.nxdat) Folder with cell images 
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3 Data Analysis 

3.1 Opening and Loading Data Files 

Double click the launch icon in the designated data package location to open the data file in 

the FCS Express software. 

1. Upon opening the FCS Express software, a blank template will automatically load. 

 

2. To import data, locate and click on the “Data” tab at the top of the page. 

 

3. Click “Data List” to open the data list window. 

 

4. First import the negative control 
sample. Click on the blue (+) add 
button. The Select a Data File pop-
up window will appear. Locate and 
select your data negative control 
sample (saved from step 2.5.) and 
click open. 
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5. Repeat step 4 to import a positive control and up to four unknown samples. Scatter plots and 
data tables will auto-populate with the imported data from each sample. The generated data is 
found on page two of the FSC express layout. Click on “Apoptosis/Necrosis Results” at the 
bottom of the page to access the data table. 

 

3.2 Gate Optimization 

1. Gates may only be adjusted in the display for the negative 

control sample.  

NOTE: Adjusting the negative control gate will automatically 

adjust gates in the positive control as well as the other data 

plots.  

a. To adjust the gate, select the dot-plot by clicking on it (a 

green box outline appears around it). 

b. Click on the center of the four quadrant gate and drag it 

to the desired location. 
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2. Quadrant gating should be adjusted according to data in the negative and positive controls. 

a. In the negative control sample, the healthy, live cell population (red circle) should be in 

the bottom left quadrant. 

 

b. In the positive control sample (while moving the gate in the negative control plot), the 

necrotic or dead cell population (PI +) should be in the top right quadrant, whereas the 

apoptotic population (Annexin V + only) should be gated in the bottom right quadrant. 

 

Incorrect Gating Correct Gating 

Annexin V+  
apoptotic cells 

PI+ necrotic cells 

Na 

Correct Gating Incorrect Gating 
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3. Upon completing gate optimization, distinct cell populations should now be represented 

individually in each quadrant. 

 

3.3 Axis Optimization for Large Cells 

If you have large cells (> 15 µm in diameter), adjust the scatter plot axis as detailed below. If your cells 

are not large (< 15 µm in diameter), proceed to Section 3.4 3.4 Saving Optimized Data Files. 

1. Scatter plot parameters may need to be adjusted for all plots in order to compensate for 

samples containing large cells (> 15 µm in diameter). Select all plots by holding down the “ctrl” 

(control) button on your keyboard and then pressing the letter “a”. Red boxes will appear 

around all the plots on the sheet (see below). 

 

2. Select the “Format” tab at the top of the page.  

Not selected Selected 
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3. Select the “Axes” icon. The “Formating Axes” window will pop up. 

 

4. Change the scale of the X and Y axis.  

a. Click on the “X axis” button and change the maximum value from 50,000 to 30,000. 

b. Click on the “Y axis” button and change the maximum value from 50,000 to 30,000. 

 

5. Change the “Transition Point” at the bottom of the page from 300 to 1000. Click OK to save the 

changes.  

6. Re-adjust gating, if needed, using Section 3.2 Gate Optimization. 
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3.4 Saving Optimized Data Files 

1. Once the Data file has the optimized parameters/settings, 

click Save As. 

2. Select save as type file “Layout Files (with embedded data). 

Enter the desired file name and location, then click Save.  

 

3. The new .fey file will contain the final analyzed data set. 

 

3.5 Viewing Brightfield and Fluorescent Cell Images 

To view the brightfield and fluorescent cell images, open the image folder in the original data package 

location. Brightfield and fluorescent images are captured for the Annexin V-FITC and PI channels for this 

apoptosis assays. 
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4 Software Settings 

4.1 Default Counting Options Settings 

Click on the Options Page and select Counting Options. Verify that all selections on the instrument screen 

match the default settings shown. 

 

 

 

 

 

 

 

 

 

 

4.2 Default Apoptosis (Annexin V-FITC / PI) Assay and Cell Type Settings  

4.2.1 Assay Settings 

1. To review the assay settings, click on the pencil icon next to the FCS_Annexin V-FITC + PI Assay 

on the main Spectrum screen.  
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2. Default settings for the FCS_Annexin V-FITC + PI Assay are shown below. 

 
 

4.2.2 Cell Type Settings 

1. To review the cell type settings, click on the pencil icon next to the FCS_Annexin V-FITC Cell Type 

on the main Spectrum screen. 
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2. Default brightfield (BR) parameters settings for the FCS_Annexin V-FITC Cell Type are shown 

below. 

 

 

3. Click on the Fluorescence (FL) tab. 
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4. Default Fluorescence (FL) parameters settings for the FCS_Annexin V-FITC Cell Type are shown 

below. 

 

 

5. Click on the pencil icon under Assay on the main Spectrum screen, then click the Edit button for 

the F2 Image Cell Type on the right-hand side of the dialog box. 
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6. Default Brightfield (BR) parameters settings for the FCS_Annexin V-PI Cell Type are shown 

below. 

 
 

7. Click on the Fluorescence (FL) tab. 
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8. Default Fluorescence (FL) parameters settings for the FCS_Annexin V-PI Cell Type are shown 

below. 

 

 

  



8003392 CS1-0114 Product Insert Rev C 20 

5 Sample Adjustment Calculator 

 
1. Click on the calculator icon at the top of the screen.  
2. Select B1 Cell Concentration and click Continue. 

 
 

3. Enter the target number of cells. For the Apoptosis assay, it is 2,000,000. Click Apply Change. The 
required volume of cell sample to be spun down will appear in the Sample Adjustment window. 
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6 Importing a New FCS Express Layout 

If you are unable to locate the needed FCS Express Layout or need help importing, please contact your 

local Field Application Specialist or e-mail Revvity Support.  

1. Click on the Support icon in the bottom right corner of the Spectrum screen, then click the “Go” 

box under Online Resources. Click on the Assay Files tab. Select Annexin V-FITC / PI. Compare 

the date on the Annexin V-FITC / PI layout (.fey file) listed to the version currently saved in your 

Spectrum software. 

 

 

 

 

NOTE: To check the version in your software, click the pencil icon under Assay on the main 

Spectrum screen. The FCS Layout File name (with date) is listed toward the bottom of the Dialog 

screen. 

 

NOTE: If a newer layout is listed on-line, download the new PI Cell Cycle layout onto your 

desktop. Copy the layout by right clicking on the layout and selecting copy. 

 

2. Navigate to the START menu and select Computer. 

3. Double click the C:\ProgramData folder to open it. 

NOTE: If ProgramData folder is not present, it may be hidden. 

Follow the instructions below to show hidden folders. 

a. Click the “View” tab. 
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b. Click “Options”. 

 

c. A Folder Options menu will pop up. Select View. 

 

d. Under the “Hidden files and folders” file, select “Show hidden files, folders, and drives”. 

e. Click OK.  

f. The C:\ProgramData folder will now appear. Double-click to open.  

4. Open the Nexcelom Spectrum folder. 

5. Open FCS Express folder. 

6. Open Layouts folder. 

7. Save/Paste new layout to the Layouts folder.  
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8. Set the new Annexin V-FITC / PI layout as the default layout for the Annexin V-FITC / PI Assay by 

clicking on the pencil icon under Assay on the main Spectrum screen. 

 

9. Navigate to the bottom of the page and click on “Set FCS Layout”. 

 

10. Select the Annexin V-FITC / PI layout with the most recent date and click Open, then click Save. 

11. You have now set the new Annexin V-FITC / PI layout as the default layout for the Annexin V-

FITC / PI Assay on your Spectrum instrument. 
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7 Storage and Handling 

Store the Annexin V-FITC at 2 to 8 °C. Safety precautions must be taken when handling the solution. Please 

consult the Safety Data Sheet for more safety information, found on 

www.revvity.com/cellcountingreagents. 

8 Warranty 

This product is for RESEARCH USE ONLY and is not approved for diagnostic or therapeutic use. The product 

is warranted to meet the specifications outlined in the Certificate of Analysis when stored and used 

according to the manufacturer’s instructions. No other warranty, expressed or implied (such as 

merchantability, fitness for a particular purpose, or non-infringement), is granted. Warranty is valid until 

the expiration date stated on the product label.  

Warranty will be void if product is stored incorrectly, the recommended protocol is not followed, or the 

product is used for a different application. 

9 Ordering Information / Support 

When ordering with a Purchase Order: 
E-mail a copy of the order to Cellc-sales@revvity.com 

 
For online orders, please visit:  

https://www.revvity.com/cellcountingreagents 
 
For support, e-mail USCAN.service@revvity.com 
 

  

mailto:Cellc-sales@revvity.com
mailto:USCAN.service@revvity.com
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